Expression 3

Glossario delle voci dei menu

1. Menu Expression 3 (solo nella versione Mac)

O About Expression 3 — Su Expression 3

About Expression 3... . . ..
Fornisce informazioni sul programma

Preferences... 3,

Services > O Pre:ferences - Ifreferenze
Da qui si possono impostare le numerose preferenze

Hide Expression3  &H del software, che ci consentono di adattarlo alle

Hide Others X #H nostre abitudini e ai nostri metodi di lavoro.

. ) O Services — Servizi

Quit Expression3 Da questa voce si accede ad impostazioni tipiche dei
programmi Mac, non collegate ad Expression in
particolare.

O Hide Expression 3 e Hide Others — Nascondi Expression 3 e Nascondi
altre

Anche in questo caso si tratta di voci specifiche della versione Mac, con le quali &

possibile nascondere l’applicazione in primo piano o le altre che sono in

background.

O Quit Expression 3 — Esci da Expression 3
Il comando si commenta da solo. In Windows, con il nome di Exit, € disponibile
nel menu File.



2. Menu File

e

Fig.1 — La versione Fig.2 — La versione
Macintosh del menu File Windows del menu File

New 38N Newy Ctrl+N
Open... #0 Open... Ctrl+0
Open Recent ’ Close Ctrl+w
Close #BW

Save Ctrl+S
Save £ S B
Save As... ave As...
Save a Copy... N HA Save a Copy...
Close All Close All
Insert Bitmap... 3 Insert Bitmap... Ctrl+I
Save as Bitmap... 3B Save as Bitmap... Ctrl+Alt+B
Export > Export "
P r

ref.e ences @0 Document Setup...

Options [

Preferences... Shift+0
Document Setup... Options »
Color Management... Color Management...
Page Setup...
Print... #8P
Quit #Q Exit Ctrl+Q

Come si puo notare le voci del menu File sono quasi tutte identiche nelle due
piattaforme, fatta eccezione per qualche cambio di nome che si riferisce, peraltro,
agli stessi comandi. Da notare (e questo vale per tutte le volte che si confrontano
programmi per Macintosh con programmi per Windows) € che le scorciatoie da
tastiera in Windows presentano il tasto “comando” (reso dall’icona 3, che su
alcune tastiere € rappresentata invece da una mela, cioé cosi: ®) sostituito da
“Ctrl”. Il simbolo '\, invece, corrisponde al tasto “Alt” delle tastiere Windows,
percio € la regola che sulle tastiere destinate ad entrambe le piattaforme, i due
simboli compaiano 'uno sopra l’altro.

Le voci dei menu sono raggruppate logicamente ed i gruppi sono separati da una
linea orizzontale. Cosi avremo il gruppo che consente di operare sui file (New,
Open, Close, ecc.), il gruppo di gestione e salvataggio di file, ecc., come in altri
software. Vediamo ora i comandi specifici di Expression 3...

O Insert Bitmap - Consente di inserire immagini nei formati raster piu
importanti, tra i quali Photoshop (PSD), Tiff, Jpeg, ecc.



v All supported formats
Photoshop format

Fig.3 — A sinistra: i formati bitmap che possono
essere inseriti nei documenti di Expression 3.

TIFF format

JPEGC image

BMP format

z?tcfic:;:r;ft O Save as bitmap — Salva come bitmap

EPS format Consente di salvare il documento di lavorazione
CIN format in formato bitmap, perdendo cosi le informazioni
ooy vettoriali. I formati bitmap di salvataggio non
mrfpof::;at concidono esattamente con tutti quelli previsti
FLM format per limportazione, ma i piu utili sono tutti
PCX format presenti.

PCD format

PXR format

TCA format O Export — Esporta

O Options — Opzioni

In questo caso si salva in formati che
mantengono le informazioni vettoriali, piu
precisamente: in [llustrator, Flash, EPS e PDF.

Sono preferenze relative alla visualizzazione dei tracciati vettoriali, comprendenti:

Show Freehand pen pressure trail — Mostra il tracciato della
pressione della penna a mano libera

Questa opzione, se selezionata, fa si che si veda lo spessore della
pennellata, che risultera variabile nel caso in cui si disegni con una
tavoletta grafica sensibile alla pressione (dovra in questo caso essere
abilitata la preferenze “Enable pressure sensitivity”).

Highlight new freehand paths - Evidenzia i nuovi tracciati a mano
libera

Funzione che in genere conviene mantenere selezionata, per tenere
sempre sotto osservazione i tracciati nascosti, altrimenti dissimulati
dalle “pennellate”.

Show selected object nodes — Mostra i nodi degli oggetti selezionati
Funzione in attiva di default, che assicura la visualizzazione dei punti di
controllo (nodi) del tracciato selezionato, rendendone piu semplice la
modifica.

Auto commit transform - Trasformazione automatica

Quando questa funzione & attiva, l’eventuale trasformazione non
concerne soltanto il riempimento, ma anche la forma stessa della
pennellata, il cui spessore variera in base all’entita della deformazione
applicata. Solitamente questa opzione non viene attivata di default.

Draw tools append to path — Aggancia al tracciato gli strumenti di
disegno

Funzione che consente di agganciare un nuovo tracciato ad un
precedente tracciato aperto.



O Document Setup — Impostazione del documento
Funzione con cui si sceglie il formato della carta. Si puo definire anche un proprio
formato personale.

O Color Management — Gestione del colore

Da qui si accede al controllo del colore. Tra le impostazioni piu importanti vi € il
profilo del dispositivo di visualizzazione (il monitor) e la resa cromatica.
Quest’ultima € importante nel caso in cui si debba convertire un documento dal
profilo cromatico originario a quello di lavorazione. I metodi sono i seguenti:

Color Management Setup

Monitor Profile: iMac ﬂ | * Rel.Colorimetric ?]

p |

Use Sys. Profile

CMYK Profile: Profilo CMYK Generico = Fig.4 — La finestra di
gestione del colore.

[ Proofing for: EPSON Stylus Photo 1200 360dpi Ink J..

(W Enable Color Management

(

Cancel ) ( oK \

Percettivo - I colori cambiano, ma sono preservate le variazioni tonali.
Saturazione — E mantenuta la saturazione, ma altri attributi dei colori
cambiano.

Colorimetrico Relativo — Questo metodo sostituisce i colori fuori gamma con
i piu vicini incontrati, dopo aver effettuato un aggiustamento complessivo alla
mappa del punto di bianco del colore iniziale a quello di destinazione nello
spazio colore. Questo € l'intento colorimetrico pre impostato in Expression 3.
Colorimetrico Assoluto — Questo approccio € simile al precedente, ma senza
che sia ridefinito il punto di bianco.

O Page Setup - Impostazione della pagina (Solo nella versione Mac)
Funzione simile a “Document Setup”, ma piu orientata alla stampa. Nella
versione Windows di Expression 3 esiste soltanto “Document Setup”, che
assomma le caratteristiche dei due comandi.

O Print - Stampa
Il significato € intuitivo.



3. Menu Edit (It.: “Elabora”)

/ ?i

Fig.5 — La versione Fig.6 — La versione
Macintosh del menu Edit. Windows del menu Edit.
Undo Pen 387 Undo Translate Ctrl+Z
Cut ggx Cut Ctrl+X
Copy % C Copy Ctrl+C
Clear Clear
Duplicate #D Duplicate Ctrl+D
Clone Clone
Select All 3$A Select All Ctrl+A
Deselect All T #A Deselect All Shift+Ctrl+A
Invert Selection Invert Selection
Select By... Select By...
Crop Marks > Crop Marks >

Set Ruler Origin Set Ruler Origin

O Undo - Annulla

Funzione con cui si annulla l'ultima operazione. Se si digita piu volte la
combinazione 8 + Z (Mac) o Ctrl + Z (Win), si annulleranno tante operazioni
quante le volte in cui il comando sara applicato. Il limite impostato nelle
preferenze € di default pari a 40, ma puo essere modificato. Il numero degli
annullamenti influisce sulla RAM necessaria al programma per funzionare al
meglio. !

O Redo - Ripristina
Operazione inversa all’annullamento, che come quest’ultimo puo essere applicata
piu volte di seguito, anche in rapida successione.

O Cut, Copy, Paste, Clear — Taglia, Copia, Incolla, Elimina
Operazioni dal significato ovvio. Le varianti Paste in front, Paste in Back, Paster

"1 nome subito dopo la voce “Undo” corrisponde a quello dell’ultima operazione.
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with layer fanno si che si possa incollare gli oggetti messi in memoria,
rispettivamente: in primo piano, sullo sfondo, o assieme a tutto il livello al quale
appartengono (o appartenevano).

O Duplicate, Clone — Duplica, Clona

Operazioni dal significato simile. Un clone € un duplicato esatto di un certo
oggetto. La differenza tra le due operazioni di clonazione e duplicazione € che
nella prima si deve sempre partire dell’originale per duplicare, mentre nella
seconda si puod procedere anche da una copia.

O Select All, Deselect, Invert Selection - Seleziona Tutto, Deseleziona,
Inverti la Selezione

Si tratta di funzioni proprie di tutti i programmi di grafica, con in aggiunta due

utili varianti:

» Select By — Seleziona per...
Funzione che consente di impostare le selezioni in base al tratto, al
riempimento e al tipo di pennellata (“stroke”).

» Select Master — Seleziona l’oggetto principale (in una clonazione)
Funzione con la quale si seleziona la sorgente in una serie di oggetti
duplicati.

O Crop Marks - Marcatori di ritaglio

Questa voce, tramite alcuni comandi accessibili dal suo sottomenu, permette di
impostare i margini per ritagliare una parte dell’area del documento, o il
rettangolo di selezione di uno o piu oggetti.

O Set Rulers Origin — Imposta Uorigine dei righelli
Permette di impostare come origine un punto diverso da quello costituito, per
default, da uno dei vertici del rettangolo del documento.



4. Menu Arrange (It.: “Disponi”)

f 5@’5

Fig.7 — La versione Fig.8 — La versione Windows
Macintosh del menu Arrange. del menu Arrange.
To Front R To Front Ctrl+Page up
To Back ¥ To Back Ctrl+Page down
Up One 3 Up One Page up
Down One $ Down One Page down
Group Ctrl+G
Make Warp Group oW Make Warp Group Shift+w
Repeat Last Transform Repeat Last Transform
Repeat Accumulated Transform Repeat Accumulated Transform
Reset Transform Reset Transform
Commit Transform Commit Transform
Align > Align >
Distribute B Distribute »
Stack B Stack »

O To Front, To Back, Up One, Down one — Davanti, Sullo sfondo, Avanti di
uno, Indietro di uno

Funzioni che modificano 1'ordine con cui si sovrappongono gli oggetti nell’area di

lavoro.

O Group, Ungroup — Raggruppa, Separa

Con “Raggruppa” si possono raggruppare gli oggetti, ad esempio per facilitarne lo
spostamento o la trasformazione simultanea. “Separa” € ovviamente l'operazione
inversa. Quando si raggruppano piu oggetti questi non perdono affatto le loro
caratteristiche individuali (tratto, riempimento, stroke, ecc.), come invece
accadrebbe con il comando “Unisci” (menu Objects>Path Operations>Unite).

0O Make Warp Group — Crea un gruppo di deformazione

Si tratta di una delle piu utili e affascinanti funzioni di Expression, con la quale si
possono deformare oggetti singoli o gruppi agendo sui nodi di una rete che fa da
box di contenimento. La frequenza dei nodi pud essere regolata tramite il
comando Objects>Warp Mesh, scegliendo la voce “Increase” (“Incrementa”)
oppure “Decrease” (“Diminuisci”). Per applicare le deformazioni, eliminando la
“rete di deformazione” (“Warp Mesh”), si ricorre ad “Ungroup”. Per annullare le
deformazioni riportando i nodi della rete alla loro posizione di default nella griglia
iniziale, il comando da impartire ¢: menu Objects>Warp Mesh>Reset Grid.
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Fig.9 — Qui sopra: esempio di
applicazione della Warp Mesh

O Repeat Last Transform, Repeat Accumulated Transform, Reset
Transform, Commit Transform - Ripeti l'ultima trasformazione, Ripeti
tutte le trasformazioni sommate, Annulla le trasformazioni, Esegui
trasformazione
Sono tutti comandi che annullano o ripristinano le ultime operazioni
effettuate tramite le voci sui gruppi del menu Arrange. La loro utilita & un po’
dubbia, dato che ripetono un po’ le funzioni di “Annullamento” e “Ripristino”
del menu File.

O Align - Allinea
E una funzione molto utile quando si deve dare ordine ad un insieme di piu
oggetti (previamente selezionati). Le possibilita sono:

» Top Edges — Margini superiori
Gli oggetti saranno allineati ai loro margini superiori.

» Bottom Edges - Margini inferiori
Gli oggetti saranno allineati ai loro margini inferiori.

» Left Edges — Margini sinistri
Gli oggetti saranno allineati ai loro margini sinistri.

» Right Edges — Margini destri
Gli oggetti saranno allineati ai loro margini destri.

» V. Centers — Centri in verticale
Gli oggetti avranno i loro centri giacenti su una retta orizzontale. Tutte
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le loro altezze saranno disposte simmetricamente attorno a tale retta.
Cambieranno solo le ordinate degli oggetti.

* H. Centers - Centri in orizzontale
Gli oggetti avranno i loro centri giacenti su una retta verticale. Tutte le
loro larghezze saranno disposte simmetricamente attorno a tale retta.
Cambieranno solo le ascisse degli oggetti.

O Distribute — Distribuisci

E una funzione simile all’allineamento, ma in questo caso leffetto & una
distribuzione regolare, cio¢ una disposizione degli oggetti in modo tale che i loro
margini (superiore, inferiore, sinistro o destro) o i loro centri siano collocati a
distanze regolari. 2

O Stack - Pila
E un insieme di comandi di distribuzione la cui utilita non é evidente.

» Upwards - Verso I’alto
Gli oggetti selezionati sono distribuiti in verticale ad eguali intervalli.
L’oggetto pit1 basso rimane dov’e.

* Downwards - Verso il basso
Gli oggetti selezionati sono distribuiti in verticale ad eguali intervalli.
L’oggetto piu alto rimane dov’e.

» To the left — Verso sinistra
Gli oggetti selezionati sono distribuiti in orizzontale ad eguali intervalli.
L’oggetto piu a destra resta dov’e.

» To the right — Verso destra
Gli oggetti selezionati sono distribuiti in orizzontale ad eguali intervalli.
L’oggetto piu a sinistra resta dov’e.

* Applicando in successione i comandi V. Centers e H. Centers si ottiene che tutte le figure divengano concentriche.
Questo ¢ valido sia per Align che per Distribute.



5. Menu Objects (It.: “Oggetti”)

Fig.9 — La versione Fig. 10 — La versione
Macintosh del menii Objects. Windows del menu Objects.

Compound Object I Compound Object »
Clipper > Clipper 4
Text on Path B Text on Path >
G.mde > Guide »
Bitmap o o .
Effect Lines B e
Effect Lines »
Unstructure U
Unstructure Shift+Ctrl+U
Reverse Path #BR
Join Path > Reverse Path Ctrl+R
Close Path = Join Path ,
Smooth Path... Close Path 4
Blend Paths...
Stroke W'dt,h > Smooth Path...
Softedge Width I
Stroke Width »
Set opacities... Softedge Width >
Arc Mode B
Node Continuity - Set Opacities...
Node Marking 3
Path Operations b Arc Mode g
Warp Mesh > Node Continuity »
Node Marking ’
Path Operations v
Warp Mesh »
Properties...

O Compound - Componi
Questa voce si applica a selezioni multiple di due o piu oggetti ed ¢ composta di
due comandi: Make e Release (Crea e Rilascia).

* Make - Crea
L’effetto dell’applicazione di questo comando a due o piu oggetti ¢ di
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unire piu tracciati in uno solo. Dopo !'unione il tracciato e il
riempimento avranno le stesse caratteristiche. Come esempio, si
possono osservare le due coppie di figure seguenti. Come si puo notare,
gli oggetti risultanti dall’operazione assumono contorno e riempimento
dell’oggetto posto in secondo piano.

* Release - Rilascia
L’'operazione annulla la precedente, ma non ripristina i tratti e i

riempimenti originali. Gli oggetti tornano indipendenti, ma con tratti e
riempimenti eguali.

o
*

Fig.11 — Comando “Compound”. A sinistra:
due coppie di oggetti selezionati prima
dell’applicazione del comando “compound”. A
destra, le due coppie dopo lapplicazione del
comando.
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O Clipper - Tagliatore

Questo comando crea quello che in altri software € denominato “gruppo di
ritaglio”, cioé un’operazione con la quale si usa la sagoma di un oggetto per
ritagliarne uno o piu di uno. Piu esattamente, il tracciato che fa da “taglierina” €
simile ad una maschera sagomata attraverso la quale si possono scorgere le parti
degli altri oggetti che essa copre. Anche dopo l'operazione, le parti derivanti dai
due oggetti possono essere modificate separatamente. Le opzioni sono:

» Make with Top Path - Crea (ritaglia) con il tracciato superiore

» Make with Bottom Path - Crea (ritaglia) con il tracciato inferiore

* Release - Rilascia
Quest’ultima operazione ripristina totalmente l’assetto originale degli
oggetti prima del taglio.

Fig.12 - Make (a Clipping Path) with
Bottom Path - Crea (un tracciato di
ritaglio) con il tracciato inferiore. In
questo esempio, la sagoma della stella diventa
una sorta di “finestra” che “taglia” le sagome dei
quadrati che le sono posti davanti.
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Figg.13, 14, 15 — Il clipper puo essere applicato anche
alla combinazione di un’immagine bitmap con un
tracciato. Nell’'esempio si puo notare come il testo
“giaguaro”, dopo essere stato trasformato in un tracciato
unico (immagine 13), ritagli la foto posta sullo sfondo.
Nelle immagini 14 e 15 si vede qual é il risultato finale.
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O Text on Path — Testo su tracciato
Questo comando fa si che un testo possa essere disposto sul contorno di un
tracciato, seguendone la forma (Attach Text) o inserito al suo interno (Attach

Area Text).

TLSTO M RROVA

Fig.16 — Testo e tracciato
prima e dopo il loro
collegamento.

Utilizzando un secondo tracciato invisibile, pit ampio di quello attorno al quale
vogliamo che il testo apparentemente scorra, si puo anche aggiungere un margine
esterno (figura qui sotto). La stessa cosa si puo fare per assegnare un margine al
testo inserito all’interno del tracciato.

Fig.17 — Testo attorno ad un
tracciato, con margine.
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O Guide — Guide

Con questa voce si puo trasformare qualsiasi tracciato in una guida, alla quale
agganciare punti e tracciati. La funzione € potenzialmente molto utile, ma per
usarla al meglio occorre fare buon uso della propria immaginazione e intuizione.
Un impiego interessante € quello che serve per creare delle lettere alla maniera
antica, cioé a partire da circoli e archi intrecciati. Scegliendo “release” tutte le
guide create saranno trasformate di nuovo nei tracciati iniziali.

O Bitmap
Comprende diversi utilissimi comandi:

* Make Bitmap - Crea Bitmap
Tale comando trasforma qualsiasi selezione in un nuovo oggetto bitmap,
perdendo le informazioni vettoriali degli oggetti di partenza.

» Autotrace Bitmap - Autotraccia Bitmap
E la funzione con la quale si vettorializza un’immagine bitmap. E
impostabile il numero dei passaggi e il grado di precisione. Utile, ad
esempio, quando si deve tradurre un logo disegnato a mano, poi
acquisito con lo scanner, nel suo corrispondente vettoriale.

» Export Bitmap - Esporta Bitmap
La funzione, a differenza dell’analogo comando del menu File (Save
Bitmap) si applica ai soli oggetti bitmap selezionati nel documento
attivo.

O Unstructure — Destruttura

L’effetto si applica alle pennellate strutturate (purché vettoriali), delle quali viene
“aperto” il tracciato che minutamente le compone, mettendo in vista tutti i punti
di controllo che le costituiscono.

O Convert to Path — Converti in tracciato
Operazione che si usa per trasformare una scritta qualsiasi in un tracciato
vettoriale modificabile.

O Reverse Path - Inverti tracciato

Cambia la direzione del tracciato, con effetti sulla pennellata se in questa vi € una
sequenza non invertibile di sezioni. L’'operazione non ha effetto sulle pennellate
nelle quali non vi € distinzione fra inizio e fine.

O Join Path- Congiungi tracciato
Unisce due tracciati aperti in uno solo.

O Close Path- Chiudi tracciato
Il comando trasforma un tracciato aperto in un tracciato chiuso.

O Blend Paths- Fondi tracciati

Funzione con la quale si fondono due tracciati, con i relativi riempimenti, con
leffetto di un’intercalazione i cui passaggi vengono definiti in una finestra di
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preferenze.

O Smooth Path—- Ammorbidisci il tracciato
Funzione che arrotonda un tracciato.

O Stroke Width e Soft Edge Width — Larghezza Pennellata e Larghezza del
margine morbido

Due comandi che consentono di incrementare (Increase), o diminuire (Decrease),

rispettivamente, la larghezza del tratto di contorno e la larghezza del margine

sfumato (se presente) di una forma.

O Remove Ref Vector — Rimuovi vettore di riferimento

Funzione che rimuove un tracciato (“vettore”) che €& servito da guida per una
fusione vettoriale. Nella Tool Box € presente uno strumento (d’'uso, invero, un po’
difficile) che serve a definire l'orientamento degli oggetti da sottoporre a fusione

(Path Blending).
f
"
4

Fig.18 - Fusioni di
tracciati vettoriali.

O Set Opacity — Regola opacita
E la stessa funzione svolta da due comodi cursori nella finestra Paint Style.
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Le funzioni di combinazione dei tracciati del menu Objects

Le ultime voci del menu Objects, escluse Arc Mode ¢ Mesh Warp, sono
operazioni di combinazione di tracciati (Path Operations) o di impostazione dei
tipi di nodo (Node Continuity e Node Marking). Tutte queste operazioni
risultano di piu rapida (e intuitiva) applicazione se attivate dalla finestra
Attributes.

O Arc Mode - Modalita (di rappresentazione — N.d.R.) dell’arco

= Open Arc - Arco Aperto
= Pie- Fetta di torta
= With Chord - Con corda

O Node Continuity — Continuita (della curva — N.d.R.) nel nodo

» Symmetrical - Simmetrica
Tangenti e curvatura sono le stesse a destra e a sinistra del nodo.

* Smooth - Morbida
La tangente € unica nel nodo, ma la curvatura € asimmetrica rispetto al
nodo (questo, ad esempio, € tipico dei punti di “flesso” della curva),
ovvero in parte concava e in parte convessa.

» Angle Locked - Angolo bloccato
Le tangenti sinistra e destra hanno diverso orientamento, ma formano
un angolo costante. I nodo ¢ dunque un punto “angoloso”, o di
“discontinuita” della curva.

*» Unconstrained - Non vincolata
Nessuna relazione esiste tra le tangenti e la curvatura, a sinistra e a
destra del nodo.

O Path Operations — Operazioni sui tracciati
Dati due tracciati chiusi A in primo piano e B in secondo piano, si conseguono i
seguenti effetti:

» Unite - Unisci
Si ottiene un terzo tracciato C, che € somma dei contorni A e B.

» Front Minus Back - Anteriore meno posteriore
Si ottiene un terzo tracciato C, che é la differenza del contorno A meno il
contorno B.

» Back Minus Front — Posteriore meno anteriore
Si ottiene un terzo tracciato C, che € la differenza del contorno B meno
il contorno A.

» Intersection - Intersezione
Si ottiene un terzo tracciato C, che € dato dall’intersezione, vale a dire
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dall’area comune delimitata dai contorni A e B.
» Divide - Dividi
Si ottengono tre tracciati, C, D, E, dati rispettivamente:
o C dallintersezione di A e B;
o D da A meno C;
o E da B meno C.

0O Warp Mesh - Rete di deformazione
Di questa voce e del suo sottomenu si € gia trattato, con riferimento al comando
Make Warp Group del menu Arrange.

6. Menu Stroke (It.: “Pennellata”)

Ay

Fig.19 — La versione Fig.20 — La versione
Macintosh del menu Stroke. Windows del menu Stroke.
New Stroke Definition New Stroke Definition

Edit Stroke Definition
Edit Stroke Definition

Set as Quick Stroke...

Anchor [ Set as Quick Stroke...
Repeatin I

peating Anchor »
Reset Stroke Shear Repeating N

Reset Stroke Shear
Set Stroke Twist...

Set Stroke Twist...
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O New Stroke Definition — Definizione di una nuova pennellata
Comando che trasforma qualsiasi tracciato vettoriale, comprese le font, in una
nuovo tratto, con il quale “pennellare” descrivendo tracciati di qualsiasi forma.

Questa ¢ la procedura:

* siseleziona un oggetto vettoriale (qui una lettera “P”);

(2 NONS) NoName*
+ -
-
=
™ [ == |

* Siregolano i margini attorno
all’oggetto, spostando i triangolini grigi
in rilievo e infine si clicca sulla freccia
(in basso a sinistra, nella cornice
inferiore del box di definizione).

si fa click sulla voce New
Stroke Definition,
causando 'apparizione del
box riprodotto qui a
sinistra;

si seleziona la figura scelta
all’interno del box;

si sceglie se si desidera
che la figura sia ripetuta (e
quante volte) lungo il
percorso della pennellata,
o se si preferisce che la
figura venga stirata. Nel
primo caso si clicca
sull’icona del “cancello”
(Repeat Tool) nella
ToolBox.

(&) ToolBox

1) ) A
Q

gLy e

Ok

%
G

l » Nella finestra successiva si assegna un
- nome al nuovo pennello (nell’esempio:
“Lettera P”), osservandolo apparire nella
lista della finestra Stroke.

Define Stroke?

Stroke Name:

Folder:

Default Width:

Lettera P ( OK )
D W Y
o C Cancel )

* Quando la nuova pennellata sara stata definita, si potra “dipingere”

con la nuova figura.
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Fig.21 — Una pennellata
ottenuta con la lettera “P”.

d,
d Q%
N
P

O Delete Stroke Definition — Elimina la definizione della pennellata

O Edit Stroke Definition — Elabora la definizione (...)
Comando che permette di modificare la definizione della pennellata.

O Add Stroke View - Aggiungi vista sulla pennellata

Permette di trasformare una qualsiasi pennellata in un set di fotogrammi, grazie
al quale si susseguiranno lungo un tracciato tante forme diverse quante saranno
le “viste” inserite (qui intese come fotogrammi). Spiegare come ottenere una
pennellata “a fotogrammi” esula dal carattere sintetico di questa dispensa, percio

si rimanda per i dettagli alla guida completa di Expression 3.

O Remove Stroke View — Rimuovi vista sulla pennellata
Elimina uno alla volta i “fotogrammi” introdotti nella pennellata.

O Define Bitmap Stroke — Definisci pennellata bitmap
Definisce una nuova pennellata a partire da un’immagine bitmap.
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Variare ancoraggi e ripetizioni

Expression permette di decidere liberamente non soltanto se vogliamo che il
motivo grafico sia ripetuto o stirato per tutta la lunghezza del tratto, ma anche di
calibrare con precisione quale sara l'intervallo entro cui sara valida la ripetizione e
quali parti invece assegnare allo “stiramento” (stretching). Tale flessibilita di
definizione € resa possibile dai comandi Anchor e Repeat del menu Stroke.

Fig.23 — Utilizzo combinato di
“anchor” e “repeat” nella
definizione della pennellata.

Ad esempio, la figura a € composta da una “testa”, un corpo e una “coda”. A meta
del corpo € situato un cuore.

Se si selezionano separatamente i tre oggetti (la selezione va effettuata nel box di
definizione), si possono ad esempio sperimentare le seguenti combinazioni:

A. semplice skeletal stroke;

B. testa e coda della freccia ancorati all’inizio e alla fine;

C. caso simile al B, ma il cuore € ancorato al 30% circa di distanza dalla
testa;

D. come in B, ma questa volta il cuore si ripete, tra i limiti del 30% e del
70% dalla testa e dalla fine della freccia;

E. come in D, ma con i limiti della ripetizione ancorati all’inizio e alla
fine della freccia.

Queste possibilita di variazione si prestano all’invenzione di invenzioni grafiche
originali, ma richiedono un po’ di pratica.

O Set Stroke Twirl - Imposta la rotazione della pennellata
Comando con il quale si ottiene l'avvitamento della pennellata su se stessa. I
valori impostabili si riferiscono al numero delle torsioni.

T (
Fig.24 — Applicazione di un (

effetto “twirl” alla pennellata.



[0 Reset Stroke Shear — Annulla la deformazione ,
Fig.25 — Significato di
alcune icone nella finestra

“Attributes”.
shear
(deforma) ® 0 Attributes
: 7 IT|iF (7

= S b it
I"‘ |-~ ‘:,

’
R

ribbon mode (modo a nastro) elliptical mode (modo ellittico)

Comando che ripristina lo stato iniziale di una pennellata, dopo che essa ¢ stata
modificata tramite il cursore a destra dell’icona Shear, nella finestra Attributes.

O Reverse Ribbon Folds — Annulla le pieghe (“folds”) a nastro (“ribbon”).
Comando che ripristina lo stato normale della pennellata dopo che sia stato
applicato un effetto “Ribbon Fold”.

O Set Ellipse Ratio - Imposta il rapporto nell’ellisse

E un comando che modifica il rapporto fra larghezza e altezza della forma usata
come pennellata. Il valore che mantiene la forma normale € 90. Il valore di
massima deformazione € 10.

7. Menu PS-Plugins (It.: “Moduli aggiuntivi di Photoshop”)

Questo menu consente di utilizzare i moduli aggiuntivi, o “filtri” di Photoshop,
purché la versione installata nel sistema sia compatibile con Expression 3.
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8. Menu View (It.: “Vista”)

. [
/ 35

Fig.26 — La versione Fig.27 — La versione
Macintosh del menu View. Windows del menu View.
Show [S Show »
Snap > Snap »
Display Quality > Display Quality ’
Onlon Skln | 4 Onion Sk|n »
Turn Off Highlights Temporarily Turn Off Highlights Temporarily E
Zoom In %+ Zoom In Ctrl+Plus (+)
;oom OUtS lecti ﬁ; Zoom Out Ctrl+Minus (-)
oom on Selection . .
. Zoom on Selection Shift+Z
View All oz View Al
Actual Size N U
Center View Actual Size Home
Center View Shift+Home
Rotate Clockwise ‘ :
Rotate Anti-Clockwise { Rotate Clockwise s
Reset View Rotation \ Rotate Anti-Clockwise {
Reset View Rotation End
New View
NGW ‘.’ieV\(

O Show - Mostra
La voce consente di mostrare i righelli e la griglia.

O Snap - Aggancia
Da qui si puo far si che gli oggetti si aggancino alle guide, alla griglia e ai nodi.

O Display Quality — Qualita di visualizzazione
E possibile scegliere tra:

* Path - Tracciato

» Wireframe - Rete a fil di ferro

* Preview — Anteprima

» Better Preview — Anteprima migliore

O Onion Skin - Pelle di cipolla (letteralmente)

Si tratta di una tecnica usata dagli animatori, con la quale, in una sequenza di
disegni (o fotogrammi), un solo fotogramma é& visualizzato con opacita piena,
mentre gli altri sono semitrasparenti. In Expression questa funzione si puo
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utilizzare per osservare in trasparenza i file di Expression aperti sotto quello che &
in primo piano.

O Turn Off Highlights Temporarily - Disattiva temporaneamente
I’evidenziazione

Comando che disattiva temporaneamente la selezione da uno o piu tracciati

nell’area di lavoro.

O Zoom In, Zoom Out, Zoom On Selection — Zoom diretto (o ingrandimento),
Zoom inverso (o allargamento), Zoom sulla selezione

O View All — Guarda tutto
La funzione allarga la visione a tutti gli oggetti presenti sul documento e sull’area
di lavoro.

O Actual View — Vista attuale
Ripristina la vista degli oggetti all’'ultima zoomata.

O Center View — Vista centrale

Vedute ruotate

Expression da la possibilita, come accadrebbe con un foglio concreto su
un’autentica scrivania, di ruotare il foglio virtuale per osservare gli oggetti anche
da altre angolazioni. In queste viste le guide si mantengono allineate ai righelli e
non ai alti del documento ruotato. Se si ripristina la veduta normale, le guide
create durante la fase ruotata, rimarranno oblique e, in caso di spostamento, si
potranno muovere soltanto parallelamente a se stesse.

Fig.28 — Guide normali e
ruotate.

O Rotate Clockwise — Ruota in senso orario
Ruota il documento in senso orario.

O Rotate Anti Clockwise — Ruota in senso antiorario
Ruota il documento in senso antiorario.
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O Reset View Rotation — Ripristina la rotazione della veduta
Riporta il documento allineato alle verticali e alle orizzontali.

O New View - Nuova vista
Apre una nuova finestra del documento, sulla quale si puo zoomare ed effettuare
rotazioni di vista indipendentemente da altre finestre gia aperte.

O Edit Warp Group — Elabora Gruppo di Deformazione

Apre una finestra speciale che permette di modificare separatamente i tracciati
degli oggetti compresi in un gruppo di deformazione. Una volta finito, si chiude la
finestra e gli oggetti risulteranno gia aggiornati nel gruppo di deformazione nel
quale sono inseriti.

9. Menu Windows (It.: “Finestre”)

Questo menu permette di aprire e chiudere, come si puo intuire, tutte le finestre
con gli strumenti e le opzioni del programma.

it/

;
™

Fig.29 — La versione Macintosh Fig.30 — La versione
del menu Windows. Windows del menu Windows.
Cascade
v Status Bar Tile
v [F2] ToolBox v Status Bar
v [F3] Paint Style
v [F4] Attributes v ToolBox F2
v [F5] Font v Paint Style F3
v [F6] Object List v Attributes F4
[F7] Variable Width v Font F5
v [F8] Strokes Object List F6
v [F9] Transformation Variable Width F7
[F10] Item List v Strokes F8
v [F11] Colorize v Transformation F9
[F12] Effect Lines Ttem List F10
[F13] Flash Button v Colorize F11

v Effect Lines F12
v Flash Button

v 1Docl *®
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La versione Windows del menu Windows (mi si scusi per il non voluto gioco di
parole) permette, rispetto all’interfaccia per Macintosh, di disporre piu finestre sul
desktop in modalita Tile o Cascade (letteralmente: a “tegola” e a “cascata”). Nella
prima modalita, le finestre occupano in parti eguali il desktop, nella seconda sono
mostrate in sovrapposizione.

File Edit Arrange Objects Stroke PS-Plugins View Window Help
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Snap to: guide Obj Selection: Alt+Ctrl to select below. Alt+drag to move/delete guide lines.
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Fig.31 — Le finestre disposte
in modalita “tile”.

Infine, nella versione Windows, vengono elencati i documenti aperti.

10. Menu Help (It.: “Aiuto”)

Questo menu si usa in modo leggermente nelle due piattaforme, ma ovviamente il
suo significato € sempre lo stesso.

Andrea Guaraldo, 2008
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